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Данное учебно-методическое пособие содержит рекомендации по примене-

нию прикладной программы на уроках геометрии«SketchUp» -программы для быст-

рого создания и редактирования трёхмерной графики. 

Предназначена для школьников, студентов, аспирантов и педагогических ра-

ботников. 

 

 

 

 

 

 

 

 

 

 



 

Введение 

 

Современные  федеральные  государственные  образовательные  стандарты 

одной  из  основных  целей  изучения  математики  рассматривают развитие  у  уча-

щихся  пространственного  воображения  и  логического  мышления путем  система-

тического  изучения  свойств  геометрических  фигур  на плоскости  и  в  простран-

стве;  применения  этих  свойств при  решении задач  вычислительного  и  конструк-

тивного  характера. Развитие пространственного мышления учащихся является важ-

нейшей частью его интеллектуального развития в целом, поскольку играет большую 

роль не только при изучении геометрии, но и при изучении других школьных пред-

метов: географии, физики, рисования, и др. Наличие хорошего пространственного 

мышления необходимо людям разных профессий: дизайнеру, программисту, эконо-

мисту, математику. 

Анализ  степени  разработанности  проблемы методики преподаваниятем по 

изучению  пространственных  фигур  позволяет  сделать  вывод  о  том,  что  необ-

ходим  поиск  новых  методов  и  технологий.  Недостаточно  изучены возможности  

использования  компьютерных  технологий в педагогической деятельности при  

изучении  пространственных  фигур. Использование  интерактивных средств обуче-

ния   в  процессе  обучения  геометрии  поможет  педагогамформировать  простран-

ственное  мышление;  поскольку  эти  технологии  позволяют ученикамнаглядно  

представлять   трехмерные  объекты  в  деталях  и  цветовом  исполнении; позволя-

ют   проводить  анализ  свойств  и  связей  в построении  пространственных  фигур;  

рассматривать  исходные  структуры и создавать  самим  новые. 

Наличие инструментов пространственно - графического моделирования в про-

грамме«SketchUp» обусловливает созданию новых методических сценарий развития 

математического мышления, усиливается применение практико-ориентированных 

исследовательских работ. 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Рекомендации по использованию программы SketchUp на уро-

ках геометрии. 

 

SketchUp — программа для быстрого создания и редактирования трёхмерной 

графики. Проекты SketchUp сохраняются в формате *.skp. 

По сравнению со многими популярными пакетами данный обладает рядом 

преимуществ, заключающихся, в первую очередь, в почти полном отсутствии окон 

предварительных настроек. Все геометрические характеристики задаются с клавиа-

туры в поле ValueControlBox (Поле Контроля Параметров; находится в правом ниж-

нем углу рабочей области, справа от надписи Measurements — «Система Мер») во 

время или сразу после окончания действия инструмента. Эта особенность позволяет 

избежать необходимости настраивать каждый инструмент перед его применением, а 

затем редактировать возможные неучтённые ошибки, но в то же время это достоин-

ство оборачивается недостатком, когда возникает потребность в массовом измене-

нии геометрии созданных объектов. Тем не менее, такие ситуации возникают редко, 

а их исправление средствами пакета не составляет большого труда. 

Данный пакет очень удобен дляучителей  и учеников. SketchUp интуитивен и 

очень прост в обращении, так как сделан с расчётом на непрофессионалов, и позво-

ляет относительно быстро и просто достигнуть желаемого результата, используя 

привычные с детства инструменты — «линейку», «карандаш», «транспортир», «ла-

стик» в трёх плоскостях. 

Можно выполнять в 3D режиме различные геометрические построения, а так-

же потом просматривать их со всех сторон. 

SketchUp позволяет создавать различные конструкции из точек, отрезков, век-

торов, прямых, окружностей и других базовых элементов, а затем динамически из-

менять их и строить анимации. Созданные в данной динамической среде чертежи 

можно просматривать в режиме презентации на компьютере или проецируя их на 

экран с помощью мультимедийного проектора. В связи с этим особенно эффективно 

использование приложения на уроках геометрии при изучении раздела стереомет-

рии. Демонстрационные чертежи и 3d – модели помогают ученикам детально разо-

браться в основных понятиях стереометрии. 

Таким образом, использование интерактивных средств, созданных в програм-

ме SketchUp, предоставляет учителю новые возможности для оптимизации процесса 

обучения, создания содержательных и наглядных заданий. Применение программы 

SketchUp на уроках позволит более рационально использовать время на уроке, при-

менять дифференцированные подходы в обучении, вносить в урок элементы игры, 

расширять эрудированность учащихся. 



 

Программную среду SketchUp с легкостью могут освоить учащиеся, имеющие 

базовые навыки работы на компьютере и впоследствии оказывать учителю суще-

ственную помощь в подготовке новых проектов. 

Система SketchUp, как универсальный программный продукт, сочетающий в 

себе свойства систем динамической геометрии, систем вычислительной математики, 

является полноценной компьютерной математической средой, и это дает основания 

для использования ее в обучении геометрии. Применение системы SketchUp позво-

ляет по-новому строить методику изучения геометрии, повышая наглядность, уве-

личивая долю эмпирической составляющей в процессе познания геометрических 

теорий и расширяя сферу предметных и учебных задач. 

SketchUp поддерживает импорт и экспорт различных форматов двухмерной 

растровой и трёхмерной графики, в частности: *.3ds, *.dwg, *.ddf; *.jpg, *.png, 

*.bmp, *.psd. 

Импорт растровой графики имеет несколько возможностей: вставка образа в 

качестве отдельного объекта, в качестве текстуры и в качестве основы для восста-

новления трёхмерного объекта по фотографии. Экспорт в формат *.jpg осуществля-

ется в качестве снимка с рабочей области окна приложения. 

Дополнительно установленные плагины позволяют экспортировать в форматы 

*.mxs, *.atl, *.dae, *.b3d и т. д. Последующее редактирование экспортированного 

файла в соответствующих приложениях может осуществляться без каких-либо 

ограничений, а плагин VRayforSketchUp  (англ.) позволяет визуализировать трёх-

мерные сцены. 

В программе есть библиотеки компонентов, материалов и стилей рабочей об-

ласти, которые можно пополнять своими элементами. Имеется возможность уста-

навливать тени в соответствии с заданными широтой, долготой, временем суток и 

года. 

 

Рис.1 

 



 

 

К основным элементам интерфейса SketchUp относятся строка заголовка, ме-

ню, панели инструментов, область рисования, строка состояния и панель измерений.  

 

Алгоритм работы в программеSketchUp. 

 

1.Знакомство с интерфейсом. 

Строка заголовка 

Строка заголовка содержит стандартные кнопки MicrosoftWindows ("Закрыть", 

"Свернуть" и "Развернуть") в правой части, а также название файла, открытого в 

данный момент 

Запуск SketchUp. 

1. Щёлкните  2 разалевой кнопкой мышки по значку  

При запуске SketchUp отображается пустая область рисования. Если в строке 

заголовка отображается надпись "Без названия", это означает, что пользователь еще 

не сохранял работу. 

 Рис.2 

 

 

 

 

 

 

 

 

 Меню 

Меню расположены под строкой заголовка. В этих меню доступно большин-

ство инструментов, команд и настроек SketchUp. Строка меню представлена следу-

ющими элементами: "Файл", "Правка", "Вид", "Камера", "Рисование", "Инструмен-

ты", "Окно" и "Справка".  

Панели инструментов 

Панели инструментов расположены под строкой меню у левого края окна 

приложения. Набор отображаемых в них инструментов и элементов управления 

определяется пользователем. 

При запуске SketchUp отображается панель инструментов "Начальная". До-

полнительные панели инструментов можно добавить, выбрав "Вид" > "Панели ин-

струментов". 

 

 Рис.3 



 

 

 

 Рис.4 

 

 

Область рисования 

В области рисования создаются модели. 3D-пространство области рисования 

визуально определяется осями рисования. Оси рисования представлены тремя цвет-

ными прямыми, перпендикулярными друг другу. Эти оси помогают при работе чув-

ствовать направления в 3D-пространстве. 

В области рисования также имеется простая модель человека, помогающая 

представить 3D-пространство. 

Строка состояния 

Строка состояния представляет собой длинную серую прямоугольную область 

под областью рисования.  

                                                                                                                             Рис.5 

 
Слева в строке состояния отображаются подсказки для используемых в дан-

ный момент инструментов рисования, включая описание специальных функций, до-

ступных с помощью быстрых клавиш. Понаблюдайте за строкой состояния, чтобы 

узнать о расширенных возможностях инструментов SketchUp. 

Чтобы просмотреть сообщение в строке состояния полностью, используйте 

метку изменения размера для увеличения области рисования. 

Панель измерений. Поле измерений находится справа от строки состояния. 

На панели измерений при рисовании отображается информация о размерах. Для из-



 

менения размера выбранных объектов можно вводить значения на панели измере-

ний, например при создании линии определенной длины. 

Метка изменения размера окна.Справа от панели измерений находится мет-

ка, путем перетаскивания которой можно изменить размер окна программы. 

2. Работа в 3D 

Создание моделей в SketchUp состоит из двух основных операций:  

 Просмотр моделей в 3D-пространстве с помощью инструментов камеры 

("Вращать", "Увеличить масштаб", "Уменьшить масштаб", "Панорамировать"). 

 Создание двумерных поверхностей и фигур; преобразование двумерных 

поверхностей в трехмерные геометрические элементы с помощью инструмента "Тя-

ни/толкай". 

Просмотр модели в 3D-пространстве 

В SketchUp используется концепция камеры для представления точки обзора 

при просмотре модели. Проще говоря, вы (пользователь) как бы смотрите через ка-

меру на свою модель в процессе работы.  

В SketchUp есть несколько инструментов для просмотра модели в трехмерном 

пространстве. Наиболее часто используются такие инструменты камеры, как "Орби-

та", "Панорама", "Масштаб" и "В размер окна". 

3.Подготовка к работе с инструментами обзора 

Использование инструмента "Орбита"  

Инструмент "Орбита" используется для поворота камеры вокруг модели. Он 

часто используется, чтобы быстро изменить область обзора между операциями ри-

сования. Активируйте инструмент "Орбита" из панели инструментов "Камера" или 

из меню "Камера". Чтобы перемещаться по орбите вокруг модели, сделайте следу-

ющее. 

1. Нажмите на инструмент "Орбита" ( ) на панели инструментов. Указа-

тель курсора изменится на два взаимосвязанных перпендикулярных овала ( ). 

2. Нажмите кнопку мыши в любой точке области рисования. 

3. Перемещайте курсор в любом направлении, чтобы вращаться вокруг 

центра области рисования. 

Использование инструмента "Орбита" (для трехкнопочной мыши) 

При помощи трехкнопочной мыши можно "облетать" модель, не переключа-

ясь с выбранного инструмента, что ускоряет процесс рисования. Чтобы двигаться по 

орбите с помощью трехкнопочной мыши, сделайте следующее. 

1. Нажмите на инструмент "Линия" ( ) на панели инструментов. Указа-

тель курсора изменится на символ карандаша ( ). 



 

2. Нажмите и удерживайте среднюю кнопку мыши. Указатель курсора из-

менится на символ инструмента "Орбита" (  ). 

3. Перемещайте курсор в любом направлении, не отпуская среднюю кноп-

ку мыши. Камера будет перемещаться вокруг центра области рисования. 

4. Отпустите среднюю кнопку мыши, чтобы вернуться к инструменту "Ли-

ния" ( ). Указатель курсора снова примет вид карандаша ( ). 

Использование инструмента "Панорама"  

С помощью инструмента "Панорама" можно перемещать камеру (точку обзо-

ра) по вертикали и горизонтали. Выберите инструмент "Панорама" на панели ин-

струментов "Камера" или в меню "Камера". Для панорамирования с помощью ин-

струмента "Панорама" сделайте следующее. 

1. Нажмите на инструмент "Панорама" ( ). Указатель курсора изменится 

на символ руки ( ). 

2. Нажмите кнопку мыши в любой точке области рисования. 

3. Перемещайте курсор в любом направлении, чтобы получить панораму. 

Использование инструмента "Панорама" (с трехкнопочной мышью) 

При помощи трехкнопочной мыши можно панорамировать, не переключаясь с 

выбранного инструмента, что позволяет ускорить процесс рисования. Чтобы дви-

гаться по орбите с помощью трехкнопочной мыши, сделайте следующее. 

1. Нажмите на инструмент "Линия" ( ) на панели инструментов. Указа-

тель курсора изменится на символ карандаша ( ). 

2. Нажмите и удерживайте клавишу Shift. 

3. Нажмите и удерживайте среднюю кнопку мыши. Указатель курсора из-

менится на символ инструмента "Панорама" ( ). 

4. (Дополнительно): для активации инструмента "Панорама" можно также 

нажать и удерживать левую кнопку мыши при нажатой средней кнопке (колесике) 

мыши. 

Использование инструмента "Изменить масштаб"  

С помощью инструмента "Изменить масштаб" можно перемещать камеру (то 

есть точку обзора) вперед и назад. Выберите инструмент "Изменить масштаб" на 

панели инструментов "Камера" или в меню "Камера". 

1. Нажмите на инструмент "Изменить масштаб" ( ) на панели инстру-

ментов. Указатель курсора изменится на символ лупы ( ). 

2. Нажмите и удерживайте кнопку мыши в любой точке области рисова-

ния. 



 

3. Чтобы увеличить масштаб (приблизить модель), переместите курсор 

вверх, а чтобы уменьшить (отдалить модель) – вниз. 

Использование инструмента "Изменить масштаб" (для трехкнопочной 

мыши) 

При помощи трехкнопочной мыши можно увеличивать и уменьшать масштаб, 

не переключаясь с выбранного инструмента, что позволяет ускорить процесс рисо-

вания. Чтобы изменить масштаб с помощью трехкнопочной мыши, сделайте следу-

ющее. 

1. Нажмите на инструмент "Линия" ( ) на панели инструментов. Указа-

тель курсора изменится на символ карандаша ( ). 

2. Чтобы увеличить масштаб модели, поверните колесико мыши вперед. 

3. Чтобы уменьшить масштаб модели, поверните колесико мыши назад. 

Использование инструмента "В размер окна"  

Инструмент "В размер окна" автоматически выбирает такой масштаб, при ко-

тором вся модель умещается в границы области рисования, а также располагает мо-

дель по центру. Выберите инструмент "В размер окна" на панели инструментов 

"Камера" или в меню "Камера". Инструмент "В размер окна" очень удобен, когда 

модель потерялась где-то за границей области рисования или когда вас интересует 

общий вид модели. Нажмите на инструмент "В размер окна" ( ) на панели ин-

струментов. Модель будет расположена по центру области рисования. 

4. .Создание фигур с помощью инструмента "Тяни/толкай"  

С помощью инструмента "Тяни/толкай" можно вминать и вытягивать поверх-

ности, придавая моделям объем или убавляя имеющийся. Можно использовать тол-

кание и вытягивание для создания объема из любого типа грани, включая круглые, 

прямоугольные и абстрактные поверхности. Выберите инструмент "Тяни/толкай" 

либо на панели инструментов, либо в меню "Инструменты".  

Подготовка к работе с инструментом "Тяни/толкай" 

Прежде чем начать выполнять следующее упражнение, создайте новый файл. 

Чтобы создать новый файл, сделайте следующее. 

1. Выберите пункт меню Файл>Создать. Появится диалоговое окно с во-

просом о том, хотите ли вы сохранить изменения. 

2. Нажмите кнопкуНет. Появится новая чистая область рисования. 

3. Нажмите на инструмент "Прямоугольник" ( ). Указатель курсора из-

менится на символ карандаша с квадратом ( ). 

4. Нажмите на любую точку в пределах области рисования, чтобы устано-

вить первую угловую точку прямоугольника. 



 

5. Переместите курсор по диагонали. Прямоугольник протянется к курсору 

из своего первого угла. 

                                                       Рис.6 

 

 

6. Нажмите кнопку мыши еще раз, чтобы задать второй угол. Прямоуголь-

ная поверхность создается с границей со всех сторон. 

                                                      Рис.7 

 
Использование инструмента "Тяни/Толкай" 

Чтобы вмять или вытянуть поверхность, сделайте следующее. 

1. Выберите инструмент "Тяни/Толкай" ( ). Курсор примет вид паралле-

лепипеда со стрелкой вверх ( ). 

2. Нажмите на прямоугольную поверхность, созданную в предыдущем 

упражнении. 

                                                         Рис.8 

 
3. Переместите курсор, чтобы создать (или уменьшить) объем. 

                                                                                              Рис.9 

 
Чтобы начать заново, нажмите клавишу Esc в любой момент операции. 

4. Нажмите кнопку мыши еще раз, когда объем достигнет нужной величи-

ны. 



 

Можно также перемещать курсор при нажатой и удерживаемой кнопке мыши. 

В этом случае объем будет зафиксирован при отпускании кнопки. 

 

5. Рисование фигур инструментами "Окружность" , "Дуга"  и 

"Прямоугольник"  

Большинство инструментов рисования в SketchUp, таких как "Окружность", 

"Дуга" и "Прямоугольник", помогают быстро нарисовать то, что можно было бы 

нарисовать инструментом "Линия".  

Рисование кругов 

Для рисования кругов используется инструмент "Окружность". Выберите ин-

струмент "Окружность" на панели инструментов или в меню "Рисование". Чтобы 

нарисовать круг, сделайте следующее.  

1. Выберите инструмент "Окружность" ( ). Указатель курсора изме-

нится на символ карандаша с кругом. 

2. Нажмите кнопку мыши в точке, где должен быть центр круга. 

3. Переместите курсор в сторону от центра, определив таким образом ра-

диус круга. При перемещении курсора будет автоматически изменяться значение 

радиуса, отображаемое на панели измерений. Задать это значение можно и вручную 

— ввести его в указанное поле и подтвердить клавишей "Enter" (MicrosoftWindows) 

или "Return" (Mac OS X). На этой панели можно также задать количество сторон для 

многоугольника, представляющего круг. 

                                                                        Рис.10 

 
                                                                       Рис.11 

 
Чтобы начать заново, нажмите клавишу Esc в любой момент операции. 

4. Нажмите кнопку мыши еще раз, чтобы завершить круг. 

Совет. Задать радиус круга можно и перетаскиванием при нажатой кнопке 

мыши. В этом случае построение круга завершается, когда отпускается кнопка. 

Рисование дуг  



 

С помощью инструмента "Дуга"  можно рисовать дуги, которые состоят из 

множества прямых отрезков, но могут редактироваться как единое целое. Выберите 

инструмент "Дуга" на панели инструментов или в меню "Рисование". 

Дуга задается тремя координатами: начальной точкой, конечной точкой и вы-

сотой выпуклости. Расстояние между начальной и конечной точкой называется так-

же длиной хорды. Чтобы нарисовать дугу, сделайте следующее. 

1. Выберите инструмент "Дуга" ( ). Указатель курсора изменится на 

символ карандаша с дугой. 

2. Задайте начальную точку дуги, нажав кнопку мыши. 

3. Переместите курсор к конечной точке хорды. 

4. Задайте конечную точку дуги, нажав кнопку мыши еще раз. Появится 

отрезок. 

5. Перемещая курсор перпендикулярно этому отрезку, задайте высоту ду-

ги. Она будет отображаться отрезком, перпендикулярным хорде. 

                                                            Рис. 12 

 
Примечание. Чтобы начать заново, нажмите клавишу "Esc" в любой момент 

операции. 

6. Нажмите кнопку мыши в третий раз, чтобы задать высоту выпуклости. 

Рисование прямоугольников  

Нарисовать прямоугольную грань можно с помощью инструмента "Прямо-

угольник", указав два противоположных угла. Выберите инструмент "Прямоуголь-

ник" на панели инструментов или в меню "Рисование". 

Прямоугольники можно рисовать на имеющихся поверхностях или отдельно 

от имеющихся фигур (с выравниванием относительно координатной плоскости). 

Чтобы нарисовать прямоугольник, сделайте следующее. 

1. Выберите инструмент "Прямоугольник" ( ). Курсор примет вид ка-

рандаша с квадратом. 

2. Нажмите, чтобы установить первую угловую точку прямоугольника. 

3. Переместите курсор по диагонали. 

Примечание. Чтобы начать заново, нажмите клавишу Esc в любой момент 

операции. 

4. Нажмите кнопку мыши еще раз, чтобы задать вторую угловую точку. 

                                                       Рис.13 



 

 
 

5. Примеры использования программы в геометрии при построении. 

Прямая: 

1. Выберем инструмент «Линия»( .) 

2.Укажем 2 точки, через которые пройдёт прямая. 

3. Найдем середину прямой. Причем, при наведении мышки середина прямой 

выделяется голубым цветом. 

4.Найдем длину данного отрезка с помощью инструмента «Рулетка»( )), 

указав точками начало и конец отрезка. В нижней строке «Строка состоя-

ния»высвечивается длина данного отрезка. 

                                                                                               Рис.14                                                          

 
Многоугольник: 

1. Выберем инструмент «Линия» ( )вручную или инструмент «Многоугольник»

. 

2. Выберем несколько точек, обозначающих вершины, заканчивая первой точкой. 

Например, шестиугольник. 

4. Измерим периметр многоугольника. Это можно сделать, измерив длины 

сторон многоугольника, с помощью инструмента «Линия». 

Рис. 15 



 

 
 Окружность: 

1. Выберем инструмент  «Окружность» ( ). 

2. Укажем  центр окружности. 

3. Зададим необходимый радиус. 

4. С помощью инструмента «Рулетка»  можно измерить радиус и диа-

метр окружности, указав начало и конец отрезка. Причем, при наведении мышки 

программа сама указывает, где центр окружности. 

 

Построения в полотне 3D 

Призма: 

 

1. Выберем инструмент «Прямоугольник»( )или «Окружность»( ),также 

можно начертить произвольный многоугольник. 

2. В «3Д полотне» начертим многоугольник, который будет в основании 

призмы.(Рис.16)  

3. Выберем инструмент «Тяни/Толкай»( ) 

4. Щелчком по данной фигуре, вытягиваем многоугольник вверх или вниз (как 

нам нужно), образуется пространственная фигура, например, прямоугольный парал-

лелепипед.(Рис 17) 

5. Изменим цвет и текстуру, сделаем фигуру прозрачной (для того, чтобы ви-

деть невидимые грани, ребра, основания и т.д.).Выберем инструмент «Заливка», за-

тем выбираем необходимый цвет и текстуру, например «Светопроницаемые» или 

меняем «Стили»  

6. Построим диагонали данной пространственной фигуры. (Рис. 19) 

7. Построим сечения плоскостями.(Рис 20, 21,22) 

8. Выберем инструмент «Орбита» и просмотрим полученную фигуру со всех 

сторон. 

  

Рис.16 

 

 



 

 

 

 

 

 

Рис.17 

 
 

Выдавливание пространственного тела из плоской фигуры, способствует луч-

шему пониманию образования пространственных фигур.  

                                                      Рис. 18 

 
 

  Рис. 19 

 
Рис.20 

 



 

 

Рис.21 

 
 

Рис.22 

 
                                                            Рис. 23 

 
Построение пирамиды. 

1. Выбираем инструмент «Прямоугольник» ( ) 

2. Чертим прямоугольник 

3. С помощью инструмента «Линия»( )чертим диагонали прямоугольни-

ка(Рис 24) 

4. Выбираем инструмент «Переместить» или «Движение»  , кликнув по 

точке пересечения диагоналей (захватив), тянем вверх и вытягиваем пирамиду.(Рис. 

25) 

 

 

 

 

 

 



 

Рис. 24 

 
 

                                                                Рис. 25 

 
В процессе построения пирамиды, учащиеся видят, что пирамида состоит из 

четырёхугольного основания и точки, не принадлежащей плоскости основания. 

Построение конуса 

1. Выбираем инструмент «Окружность»(  )и чертим основание конуса. 

(Рис. 26) 

2. Инструментом «Линия» ( ) из центра  окружности чертим высоту ко-

нуса (Рис.27) 

3. Высоту достраиваем до прямоугольного треугольника. 

4. Кликаем  и выделяем окружность 

5. Поверхность протягиваем вдоль выбранного пути с помощью инстру-

мента «Ведение»)     (Рис.28) 

 

 

 

 

 

 

 

 



 

Рис. 26 

 
Рис. 27 

 
Рис.28 

 
При построении конуса, учащиеся очень хорошо понимают, что конус образу-

ется вращение прямоугольного треугольника вокруг своего катета. 

Пример использования инструмента «Сечение» 

1. Выбираем инструмент «Сечение» 

2. Прикрепляем плоскость к основанию пирамиды. 

3. Курсором кликаем по появившейся плоскости. 

4. Инструментом «Движение»( )двигаеим плоскость вниз и вверх. (Он 

на время скрывает часть пирамиды, делая срез ровным в одной плоскости ) (Рис.29, 

30) 

5. Инструментом «Поворот»(  )можно поворачивать плоскость сечения в 

любом направлении. 

 

 

 



 

 

Рис. 29 

 
Рис.30 

 
Рис. 31 

 
 

Выдавливание пространственного тела из плоской фигуры, способствует лучшему 

пониманию образования пространственных фигур.  

6.Построения чертежей к задачам учебников 8 и 11 классов 

Задача №140 (по учебнику Геометрия 8 класс)  

 Площади двух треугольников с общим основанием равны S1 и S2, где 

S1≠S2.Найдите площадь четырехугольника с вершинами в серединах их боковых 

сторон.                                        



 

 
№8. (ЕГЭ-2017 год под редакцией И.В. Ященко.) Через среднюю линию осно-

вания треугольной призмы, объем которой равен 52, проведена плоскость, парал-

лельная боковому ребру. Найдите объем отсеченной треугольной призмы. 

1.Для начала построим на Полотне треугольник, выбрав инструмент «Линия»  

( .) 

2.Из треугольника выдавим треугольную призму.  

3.Проведём перпендикулярные прямые через обе точки (начало и конец средней ли-

нии). 

4.Проведём параллельные прямые, соединив данные перпендикуляры. 

5. С помощью инструмента «Орбита» можно повернуть камеры вокруг моде-

ли, перемещая курсор в любом направлении. 

 
Пример использования программы SketchUp на занятиях кружка. 

Работа ученицы 8 класса(создание модели комнаты): 

 

 

 



 

 
 

 

7. Презентация 

SketchUp предоставляет замечательные возможности эффектной финальной 

«подачи» проекта – его презентации.  Прежде всего, уточним сам принцип работы 

этого механизма – представьте, что у нас в руках фотокамера, которой делается ряд 

снимков модели с разных точек (ракурсов). Затем эти снимки раскладываем в фото-

альбоме – каждый на отдельной Странице (Page). По умолчанию имеем одну, как бы 

нулевую, страницу и чтобы разложить наши снимки, добавляем первую страницу 

через меню Вид>Тур>Добавить страницу (View>Tourguide>AddPage). При этом в 

верхнем левом углу появляется панель с именами и номерами страниц, через кон-

текстное меню которой опцией Добавить (Add…) последовательно создаем нужное 

количество дополнительных страниц. Она же используется для быстрого перехода 

между страницами.  

Это пока только заготовка, а далее наступает самый творческий момент – мы 

имеем возможность по-разному оформить каждую из страниц – назначить свои па-

раметры визуализации: сам ракурс снимка (положение камеры), стили линий, теней, 

видимости/невидимости отдельных объектов и слоев и многое другое. Дополни-

тельные возможности организации и настройки показа каждой страницы открыва-

ются из Менеджера страниц (PageManager). И обязательно (!) не забываем до пере-

хода на другую страницу из текущей сохранять изменения опцией Обновить 

(Update), – опция отмены здесь не работает!  

Но и это еще далеко не финальный результат – далее фактически есть два ва-

рианта собственно «подачи» презентации: 

  1. Статичный экспорт каждой страницы, как отдельной картинки 

(File>Export>2D Graphic) с предварительно назначаемыми в окне опций (Options) 

параметрами. Одно замечание – поскольку фактически экспортируется «снимок с 

экрана» со стандартным «мониторным» разрешение 72 dpi (а экранное сглаживание 

линий (Antialiasing), в программе практически отсутствует), назначаем размер кар-

тинки по меньшей мере раза в два больше, чем в итоге необходимо. Затем открыва-

ем ее в графическом редакторе и уменьшаем до нужного размера (с пропорциональ-

ным увеличением разрешения) – за счет эффекта сглаживания получаем намного 

более качественный результат.   



 

2. Анимированный показ тех же страниц на мониторе в виде слайдшоу, т.е. 

последовательной смены «кадров» с эффектом плавного перехода между ними, а 

фактически – «проезда» камеры из одного положения в другое (на другой странице). 

В этом и состоит принципиальное отличие анимации в SketchUp от «классической», 

где анимируются еще и сами объекты. Параметры показа слайд-шоу настраиваем 

через Окно>Инфо по модели>Тур (Window>Modelinfo>Tourguide) двумя значения-

ми в секундах: Временем перехода страниц (PageTransitions) и Временем демон-

страции страницы (PageDelay).   

И здесь SketchUp еще раз поражает своими возможностями простыми сред-

ствами получать эффектные результаты – умело варьируя различные сочетания па-

раметров визуализации страниц (см. выше) и временные параметры, можно добить-

ся в слайд-шоу самых удивительных результатов – здесь все зависит от вашей твор-

ческой выдумки и терпения, а потому давать какие-то универсальные рецепты не 

имеет смысла. 

 Одно замечание по слайд-шоу: если модель достаточно сложная, скорее всего 

переходы между страницами будут «дергаными», что совсем не украшает презента-

цию (особенно при демонстрации ее заказчику) – просто компьютер не справляется 

с визуализацией.  Выход из этой ситуации один – экспорт слайд-шоу в видео-файл 

(File>Export>Animation). Особых комментариев тут не требуется – просто поэкспе-

риментируйте с опциями настройки и подберите для конкретной задачи оптималь-

ные соотношения: размер кадра / качество / размер видеофайла. Плюс потребуются 

определенные знания в части цифрового видео, прежде всего - по выбору и настрой-

ке кодека компрессии/декомпрессии видео-файла.  
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